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Presentation Tool Changes 
TrialDirector 6 features a redesigned, dynamic Presentation Toolbar, as well as new Exhibit Controls. Most tools feature a 
color palette that appears when you right-click on the tool. 

  Old New     Old New     Old New 

n/a Annotations 
 

  Stamps 
 

 

  
Callout 

Zoom  

 

Arrow 
 

 

  Yes Stamp 
 

 

  Zoom Region 
 

 

Line 
 

 

  No Stamp 
 

 

  

Projection Zoom 

(formerly Projection Zoom and Color Callout 
Border) 

 

 
 

Highlight 
 

 

  X Stamp 
 

 

  Capsule Projection   
 

 

Ellipse 
 

 

  Checkmark 
 

 

  Tear Out Projection 
 

 

Rectangle 
 

 

  Alphabet Stamp 
 

 

  Signature Compare 
 

 

Pen 
 

 

  Number Stamp 
 

 

  Moving Highlight 
 

 

Add Text Box 
 

 

  
Select Custom 
Stamp n/a 

 

  
Note: Zoom Full Page  and Zoom Fit to Width  have been 

moved to the Document/Image Control.  

Blur n/a 
 

   

 

Tip: Check www.indatacorp.com for the latest TrialDirector 6 
tutorials. 

 

Redaction 
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  Old New     Old New   

Omitted in TrialDirector 6 
n/a Application 

 

    Other     

Show 
Annotations 

 

 

  Presentation Menu 
 

 

  
 

New navigation tools 
enable you to access 
the next workbook. 
See Loading Items in 
Presentation Using 
the Toolbar. 

Hide Annotations 
  

  Load Item 
 

 

  
 

Transcript 
Search is no 
longer available. 

Edit Annotations 
  

  Clear Tools n/a 
 

  
 

New navigation tools 
enable you to access 
the previous item.  
See Loading Items in 
Presentation Using 
the Toolbar. 

Remover 
 

 

  
Status Indicator 

(changes color) 
 

 

  
 

Zone Shape Zoom is 
no longer available. 

Undo n/a 
 

  

Replace Zone 
Enabled 
 
Tip: Click the icon 
to toggle between 
Replace Zone/Push 
Zone. 

 

 

  
 

The new Undo button 
reverses any action, 
including an 
annotation. 

Redo n/a 
 

  

Push Zone Enabled 
 
Tip: Click the icon 
to toggle between 
Replace Zone/Push 
Zone. 

  

n/a `   
 

You can use the Hide 
Annotations tool or 
the Remover tool 
instead of erasing 
annotations. 

Take Screen 
Snapshot 

 

 

  
Select Zone/ 

Zone Indicator 

   

 
 

     
 

Any screen snapshots 
you take are listed in a 
Snapshots workbook. 
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Save Stage n/a 
 

  

  

Tip: You can set the 
size of this button in 
Presentation 
Preferences > 
Stage > Zone 
Indicator Sizing. 

 

 

 

 

 

 

   

 
   

 
  

 
  

 

You can use the 
Select Zone/Zone 
Indicator button to set 
the zone before 
loading the next item. 

Hide/Show 
Presentation 
(formerly Screen 
Blanker) 

 
 

    
 

Use the new Select 
Zone/Zone Indicator 
button. 

Swap Zones 
 

 
 

    
 

You can use the 
Select Custom Stamp 
tool to select an 
image after you 
specify the folder 
containing custom 
stamps in 
Presentation 
Preferences > Tools > 
Stamps. 

Rotate Zones 
 

 
 

    

 

You can use the 
Select Custom Stamp 
tool to select an 
image after you 
specify the folder 
containing custom 
stamps in 
Presentation 
Preferences > Tools > 
Stamps. 

Clear Screen 
 

 

    

    



TrialDirector 6 Help - Presenting Your Case 

4 Copyright ©2010 inData Corporation. All Rights Reserved. 

 

Presenting Your Case 
Once you've organized and prepared your case, you are ready to plan the presentation. Whether you are presenting the case 
to colleagues or a jury, TrialDirector contains the dynamic tools you need to create a professional presentation. Features 
include side-by-side exhibit comparison, on-screen annotation tools, the ability to save your dynamic presentation at various 
points, and much more.  

TrialDirector's Presentation interface appears on the Presentation Preview tab, as well as in a separate Presentation mode 
that opens in its own window. When you create workbooks and add or remove items in the main program, the same changes 
appear on the Presentation Navigation Tools if the case is open in Presentation mode. 

Monitor Configuration 

Dual monitors are ideal during presentation so that you can see the main TrialDirector window on one screen, and 
Presentation mode on the other (or displayed from a projector). You can set an option to control whether Presentation mode 
appears on the primary monitor or secondary monitor in Presentation Preferences > Stage > General. 

Learning About Presentation in TrialDirector 

Before you jump into your first presentation, it's important to spend some time learning about the following: 

• Using the Presentation Zones 

• Displaying Items in Presentation Mode 

• Controlling the Presentation Display 

• Using the Presentation Toolbar 

• Using Presentation Preview 

• Saving and Loading Stages 

Presenting Exhibits and Other Items 

As you determine the types of exhibits and other items your presentation will include, review the topics that apply: 

• Presenting Documents and Images 

• Presenting Digital Video Transcripts (DVTs) 

• Presenting Multimedia Files 

• Presenting Native Files 
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Opening and Closing Presentation Mode 
You can have both the main TrialDirector program and Presentation mode open simultaneously, or independently. 

 

Tip: If you are using dual displays (for example, a laptop plus another monitor, or a 
laptop plus a projector), you can set Presentation mode to open on the secondary 
display in Presentation Preferences > Stage > General. 

To open Presentation mode, do one of the following: 

• In TrialDirector, click the Presentation button. 

• In TrialDirector, open the View menu and click Presentation mode. 

• On the Windows Start menu, under All Programs, expand TrialDirector 6 and click TrialDirector Presentation. 
This option enables you to open Presentation mode separately. 

To switch between the main TrialDirector window and Presentation mode: 

Press ALT+TAB 

To close Presentation mode: 

Click the button to open the Presentation Menu, and then click Exit. Click Yes to confirm you want to close the program. 
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Presentation Toolbar 
The Presentation Toolbar enables you to annotate exhibits with arrows, highlights, callouts, and more. Many settings in 
Presentation Preferences influence how the tools work. 

  

 

Topics: 

Tool Descriptions 

Changing the Annotation Color 

Positioning the Toolbar 

Saving and Loading Toolbar Layouts 

Restoring the Default Toolbar 
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Tool Descriptions 

The following tables describe each of the tools available on the Presentation Toolbar. 

Annotations  

    Use to 

Arrow 
 

Click and drag to draw an arrow. The first point you click becomes the head of the arrow. 

Line 
 

Click and drag to draw a line. For example, you can use this tool to underline key 
information. 

Highlight 
 

Click and drag to highlight an area, such as text you want to emphasize. 

Ellipse 
 

Click and drag to draw an ellipse.  

•To draw a perfect circle, hold down SHIFT while you click and drag.  

•To ensure the point where you first click is in the center, hold down CTRL while you click 
and drag.  

Note: You can use both of these options together. 

Rectangle 
 

Click and drag to draw a rectangle. 

•To draw a perfect square, hold down SHIFT while you click and drag.  

•To ensure the point where you first click is in the center, hold down CTRL while you click 
and drag.  

Note: You can use both of these options together. 

Pen 
 

Click and drag to draw freeform with the pen. 

Add Text 
Box 

 

Click and drag to add a text box, sizing the default “Select text to edit” entry to the desired 
font size. Then use the Edit Annotations tool to delete the default text and add your own.  

Blur 
 

Click and drag to blur an area, such as a person's face in a photo or video. 

Redaction 
 

Click and drag to draw a redaction box. 

Note: You can enable/disable borders and "redacted" text in Presentation Preferences > 
Tools. 

  



TrialDirector 6 Help - Presenting Your Case 

8 Copyright ©2010 inData Corporation. All Rights Reserved. 

Stamps 

    Use to 

Yes Stamp 
 

Click and drag to place the YES stamp and size it as needed. 

No Stamp 
 

Click and drag to apply the no symbol and size it as needed. 

X Stamp 
 

Click and drag to apply the X stamp and size it as needed. 

Checkmark 
 

Click and drag to apply the checkmark stamp and size it as needed. 

Alphabet Stamp 
 

Click and drag to apply the selected Alphabet stamp and size it as needed. 

To select a different letter, click and hold this button until the palette appears. Then, 
select the correct letter. 

Number Stamp 
 

Click and drag to apply the selected Number stamp and size it as needed. 

To select a different number, click and hold this button until the palette appears. 
Then, select the correct number. 

Select Custom 
Stamp 

 

Click and drag to apply the selected custom stamp and size it as needed. 

To select a different custom stamp, click and hold this button until the palette 
appears. Then, select the correct number. 

  

  

Callout Zoom Tools 

 

Tip: After using one of these tools, you can quickly change the area that is projected by holding down 
the right mouse button and selecting a different part of the text, image, or video. 

    Use to 

Zoom Region 
 

Click and drag to select an area that will 
be enlarged to fit the current zone. 

Projection Zoom 

(formerly 
Projection Zoom 
and Color Callout 
Border) 

 

Click and drag to project an enlarged 
area in a rectangular box with the 
original item remaining in the 
background. To change the border color, 
right-click this tool. 
Note: You can set several options for 
Projections in Presentation Preferences > 
Tools 
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Capsule 
Projection   

 

Click and drag to project an enlarged 
area in an oval with the original item 
remaining in the background. To change 
the border color, right-click this tool. 

Tear Out 
Projection 

 

Click and drag to project an enlarged 
area in a box with ragged edges as if the 
area has been torn from the original. To 
change the border color, right-click this 
tool. 

Signature 
Compare 

 

Click and drag to select an area to display 
as a separate image. Then, repeat in 
another area (or as many areas as 
needed) for comparison purposes. 

Moving Highlight 
 

Click and drag to draw a highlighted area. 
As you scroll, the highlight appears to 
move as different parts of the text/image 
move into the area. 

  

Application Tools 

    Use to 

Show 
Annotations 

 

Display all annotations to items in all zones. 

Hide 
Annotations 

 

Hide annotations and stamps on items in all 
zones. 

Note: Callouts/Projections are not hidden. 

Edit 
Annotations 

 

Edit, move, or reshape annotations. After you 
select this tool, click on the annotation. A pale 
blue box appears that enables you to 
manipulate the annotation. 

Remover 
 

Delete annotations individually. After you 
select this tool, click on the annotation you 
want to remove.  

Undo 
 

Reverse the last action. You can continue 
clicking to step back through a series of steps. 

Redo 
 

Redo the previous action after using the Undo 
tool. You can continue clicking to step forward 
through a series of steps after multiple uses of 
Undo. 
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Take Screen 
Snapshot 

 

Capture a static image of the entire 
Presentation display. The new image is 
automatically associated with the item that is 
active at the time of capture. See Using 
Screen Shapshot and Grab Screen Commands. 

Save Stage 
 

Save the dynamic layout of your presentation 
at any point in time. See Saving and Loading 
Stages. 

Hide/Show 
Presentation 
(formerly 
Screen 
Blanker) 

 

Temporarily hide all items in all zones, then 
click again when you are ready to display 
them. 

Swap Zones 
 

Switch the position of two items.  

Rotate 
Zones 

 

Move zones one counter-clockwise rotation. 

Clear 
Screen 

 

Close all items in all zones without saving any 
annotations. 

  

Changing the Annotation Color 

 

Tip: You can create multiple instances of tools on the Quick Access Toolbar with different color 
settings. For example, if you often use both black redactions and a custom color, you can drag each 
of these to your Quick Access Toolbar. As with the other annotations, redactions have unlimited color 
possibilities. 

1. To change an annotation color, click the button to open to open the toolset. Then, right-click the tool to open the 
color palette. 

2. Select the desired color from the palette, or click the last (striped) button to open a custom Color Selection dialog 
box and specify a color. You can also set the level of opacity. 
 
The selected tool will display the new color until you change it, or until you open the Presentation menu, point to 
Toolbar, and click Restore Defaults. 
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Positioning the Toolbar (Floating/Detaching and 
Docking/Reattaching) 

The Presentation Toolbar can be detached, repositioned, and expanded to display a tool palette. If a secondary monitor is 
enabled, consider detaching the toolbar and moving it to the secondary monitor to keep jurors' attention focused on the 
exhibits shown on the primary monitor. 

To detach (float) the toolbar 

1. On the Presentation menu, point to Toolbar, and then click Detach Toolbar. 

2. Click on the left end of the toolbar and drag it to any location on the screen, or to a secondary monitor (if enabled). 

To display or hide the expanded palette 

1. While the toolbar is detached, click the button on the far right to display the expanded palette.  

2. Click the button at the top right of the palette to hide it and return to the detached toolbar. 

To reattach (dock) the toolbar 

On the Presentation menu, point to Toolbar, and then click Reattach Toolbar. 

Saving and Loading Toolbar Layouts 

Presentation Mode automatically preserves your changes to tool settings (such as color), and the Quick Access Toolbar 
between sessions. However, if multiple users share one computer or you want to use different toolbar configurations with 
different cases, you should save the toolbar layout and load it when needed. You can save and load toolbar layouts from any 
file location. 

 To save a custom toolbar layout 

1. On the Presentation menu, point to Toolbar, and then click Save Toolbar Layout. 

2. In the File name box, type a name for this toolbar layout. 

3. Click Save to save the current toolbar layout as a (*.ttb) file. 

To load a saved toolbar layout 

1. On the Presentation menu, point to Toolbar, and then click Load Toolbar Layout. 

2. Select the saved toolbar layout (*.ttb) file. 

3. Click Open. 
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Restoring the Default Toolbar 

Presentation Mode automatically preserves your changes to tool settings (such as color), and the Quick Access Toolbar 
between sessions. However, if needed, you can restore the toolbar to the default settings. 

 

Caution: Unless you save the current toolbar layout first, all changes to tool settings and the Quick 
Access Toolbar will be lost. 

On the Presentation menu, point to Toolbar, and then click Restore Defaults. 
The toolbar is immediately reset. 
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Using the Presentation Zones 

The Presentation area is divided into nine zones that you can use to display multiple case items at the same time in different 
positions, or one item on the full screen (called zone 9). The image below shows the available zones: 

 

Before you begin displaying items in Presentation mode, keep the following in mind about zones: 

• You can use any combination of zones as long as they do not overlap. For example, you could use zone 1 for a 
document, zone 6 for a surveillance video, and zone 8 for a related graphic. 

• You can set the default zone to use and other zone settings in Presentation Preferences > Stage > Zones. 

To select a particular zone before you load an item, do one of the following: 

• Move your mouse over the Select Zone/Zone Indicator icon at the far right end of the Presentation Toolbar until the 
rectangle appears over the zone you want to use, then click the mouse. 

 

• Press the corresponding function key on the keyboard (i.e., F1= zone 1, F2=zone 2, and so on). 

• Scan the barcode associated with the zone.  

Once a zone is selected, you can load an item into that zone. Each zone is independent of the other zones, which means that 
you can load and annotate an item in any zone without affecting the items in the other zones. 

Zone Modes 

The active Zone Mode influences how items move around the screen as you load and close exhibits. The icon for the active 
Zone Mode appears on the far right end of the Presentation Toolbar. 

 

Tip: In addition to using the function keys described in the table below, you can click the icon to 
toggle between Push Zone and Replace Zone. 

  

Mode Description 

Push Zone [F12] 

 

Push Zone Mode enables you to add an item to a specific zone. If you add 
an item to a zone that is already displaying an item, the old item is moved 
into another zone (unless you are adding an item into zone 9, which 
cannot be used concurrently with any other zone). 
 
For example, adding an item into zone 1 will automatically move the item 
previously in zone 1 into zone 2. Any item previously in zone 2 will be 
moved off the display. For more information, see Zone Activity in Push 
Zone Mode. 
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Replace Zone [F11] 

 

Replace Zone Mode allows you to replace the item in the active zone with 
a new item while leaving items in other zones in place.  

Example: 

1. Load an item into zone 1 by pressing [F1] and then typing the Item ID or 
scanning the appropriate barcode. 

2. Then load an item into zone 2 by pressing [F2] and then typing the Item 
ID or scanning the appropriate barcode. 

3. Replace the item in zone 1 with a new item by pressing [F1] to make 
zone 1 active, pressing [F11] to select the Replace Zone Mode, and then 
typing the Item ID.  
A small icon will appear on the right side of the toolbar to indicate you are 
in Replace Zone Mode. 

Transfer Zone [F10] The Transfer Zone Mode allows you to transfer the item in the active zone 
into another zone.  

Example: 
1. From a blank display, load an item into zone 9 by pressing [F9] and then 
typing the Item ID. 
2. Transfer the item into zone 3 by pressing [F10] to enter Transfer Zone 
Mode and then pressing [F3] to move the item into zone 3. 

After one transfer is made in Transfer Zone Mode, TrialDirector reverts 
back to Push Zone Mode or Replace Zone Mode, depending on which 
one was most recently enabled. 
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Presenting Documents and Images 
When you load a document, a photo, or other graphic image on to the Presentation display, each image is 
displayed as large as possible in the selected zone. 

After you load the file, the control bar appears collapsed beneath it:  

Click on it to expand the full controls: 

 

Keep the following in mind as you prepare a presentation that includes images: 

• To keep the jury from seeing the control bar, use Mirror Mode to control your presentation from behind the scenes. 

• You can use the [Page Up] and [Page Down] keys on your keyboard instead of the buttons on 
the control bar to page through imaged documents. 

• You can move images around the Presentation display (see Controlling the Presentation Display). 

• You can use the tools on the Presentation Toolbar to annotate and emphasize images. 

• Changes you make to an image in Presentation mode are not permanent. However, you can use 
the Save Stage tool to save the dynamic layout, or the Screen Snapshot tool to capture a static 
image of the entire screen with all annotations. 
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Presenting Digital Video Transcripts (DVTs) 
When you load a DVT on to the Presentation display, the control bar appears collapsed beneath it:  

Click on it to expand the full controls: 

 

Controlling the DVT 

• To keep the jury from seeing the control bar, use Mirror Mode to control your presentation from behind the scenes. 

• When you load a DVT in Presentation mode, TrialDirector will either begin playing it immediately or wait for you to 
click the Play button, depending on the default preference selected (see Presentation Preferences > Exhibits > Digital 
Video Transcripts > DVT Play Options) and whether you set an override in the clip properties. You can also set 
options to control whether DVTs automatically close when they finish playing, or remain open and paused. 

• To toggle between pause and play, double-click anywhere on the video. 

• When you use the controls to move to different points in the video, the transcript text is automatically repositioned 
when the video resumes playing. 

Displaying the Full DVT (Virtual Clip) 

• Transcript Manager automatically creates a virtual clip for each DVT that enables you to play the entire DVT in 
Presentation mode. It appears as "Virtual Clip (ID)" in Transcript Explorer under the deponent's name. 
Example: 

 

• To display the transcript only (no video), type the Clip ID followed by :T and press ENTER. Using the example above, 
you would type: 
MP-0721:T 
After the transcript appears, you can type -pg## and press ENTER to go to a specific page in the transcript. To go 
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to page 3, you would type: 
-pg03 

Setting the Layout of the Video and Transcript 

• The options in Presentation Preferences > Exhibits > Digital Video Transcripts give you control over the default layout 
of the video and transcript text, how text is highlighted, fonts, and more. Spend some time experimenting with these 
settings, and expand the Information text in Presentation Preferences for more information. 

• You can move DVTs around the Presentation display the same way you move images (see Controlling the 
Presentation Display). 

• To change the layout position of the video and transcript on-the-fly during presentation, press CTRL + TAB. A popup 
selection box appears where you can select a different layout. 

Viewing Attached Exhibits 

• If you've attached exhibits to a transcript in Transcript Manager, each exhibit automatically appears at the right time 
when you present the DVT. 

• You can specify whether attached exhibits open in Zone 1 (to the left of the DVT) or Zone 2 (to the right of the DVT) in 
Presentation Preferences > Exhibits > Digital Video Transcripts > Linked Exhibits. 

• You can annotate the exhibit just as if you loaded it yourself, though you may want to pause the DVT while you do so. 
• Provided you specified when to clear the attached exhibit in Transcript Manager, it will close at the appropriate time. 

However, you can also hover over the top right corner to access the controls that enable you to close it, maximize it, 
or move it to a different zone. (See Controlling the Presentation Display for more information.) 

Annotating and Emphasizing the DVT 

• You can use tools on the Presentation Toolbar to annotate and emphasize aspects of a running video and the 
transcript text. 

• Consider using Callout Zoom tools , such as Projection Zoom  or Capsule Projection to draw the jury's 
attention to the deponent's face. 
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Enabling Closed Captions 

To enable closed captioning on-the-fly during presentation, type -CC and press ENTER. (Repeat this command to disable 
closed captioning.) 
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Presenting Multimedia Files 
In TrialDirector, any audio or video file that is not associated with a transcript is referred to as a multimedia file. Surveillance 
videos and phone recordings are examples.   

After you load a multimedia file, the control bar appears collapsed beneath it:  

Click on it to expand the full controls: 

 

Keep the following in mind as you prepare a presentation that includes multimedia files: 

• To keep the jury from seeing the control bar, use Mirror Mode to control your presentation from behind the scenes. 

• When you load a multimedia file in Presentation mode, TrialDirector will either begin playing it immediately or wait for 
you to click the Play button, depending on the preference selected (see Presentation Preferences > Exhibits > 
Multimedia). You can also set a preference to control whether multimedia files automatically close when they finish 
playing, or remain open and paused. 

• You can display and play up to four videos simultaneously. 

• You can move multimedia files around the Presentation display the same way you move images (see Controlling the 
Presentation Display). 

• You can use tools on the Presentation Toolbar to annotate and emphasize aspects of a running video. For example, 
you could use the Blur tool to make a face unidentifiable, use the Ellipse tool to draw a circle around a key item, and 
use the Projection Zoom tool to enlarge a license plate. 

• To toggle between pause and play, double-click anywhere on the video. 
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Presenting Native Files 
TrialDirector displays native files, such as Microsoft Office files, in Presentation mode using the appropriate program or viewer. 
See Supported File Formats for a complete list of supported native file types. 

When you load a native file in Presentation and click on it, the embedded program becomes active and you use its tools to 
manipulate the file. You can set options in Presentation Preferences > Exhibits > Native Documents to control some aspects 
of how native files appear. 

 

Notes:  

•   With the exception of PDF files (see Advanced PDF Support Features), you cannot 
use TrialDirector tools to annotate native files. Annotate all other native files using 
the programs the files were created in. 

•   You cannot present carousels containing Microsoft Office files. 

  

  



TrialDirector 6 Help – Presenting Your Case 

                     Copyright ©2010 inData Corporation. All Rights Reserved. 21 

Controlling the Presentation Display 
TrialDirector gives you complex control of the items on the Presentation display. By selecting specific zones and using 
different zone modes, you can control where items are displayed and how they move around the Presentation display. 

You can also manually expand a zone, drag an item into another zone, or close an item using the controls that appear when 
you move your mouse over the top right corner of any exhibit. 

 

Expand a Zone 

To expand a zone, click the Maximize Zone button on the zone header controls. 

To retract an expanded item, click the button again. 

Drag an Item into Another Zone 

1. To move an item into another zone, position the cursor over the Click and Drag To Move Zone 
button on the zone header controls until the four-sided arrow appears. 

2. Click and drag the mouse pointer to the center of the zone where you want the item to be 
displayed. 

3. Check the Select Zone/Zone Indicator to ensure that the target zone is selected, as indicated by a 
red outline.  

4. Release the mouse. 
 
The item will move to the selected zone. 

Close an Item 

To close an item, click the Close Zone button on the zone header controls. 
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Using Presentation Preview 
As you organize your case and prepare for trial, you can use the Presentation Preview tab on the right side of the screen to 
see what any item in your case will look like when it is presented without having to stop and launch Presentation mode. 
Simply drag any item from Case Explorer or Document Manager to the Presentation Preview tab. 

When you are ready to present your case, Presentation Preview becomes a powerful tool for controlling your presentation 
behind the scenes using dual displays (i.e. your laptop with TrialDirector running as the primary display, and a courtroom 
projector showing Presentation mode as the secondary display). You can use either of these methods, and switch between 
them as needed: 

 

Present Preview (Mirror Mode Off) - Prepare and preview on-the-fly enhancements to your 
presentation on your laptop without impacting an ongoing presentation. At the proper moment, you 
simply click a button to insert the new information into the live presentation and the jury never sees 
you miss a beat. More Information 

 

Mirror Mode - Make real-time changes and control your live presentation entirely from Presentation 
Preview. The jury sees your annotations as you make them, views a video as you click play, etc. but 
never sees the tools or controls. The Presentation Toolbar is automatically hidden in Presentation 
mode as soon you enable Mirror Mode. More Information 

Regardless of the way you use it, Presentation Preview works just like Presentation mode and includes its own customizable 
toolbar that is saved separately from the toolbar in Presentation mode. 

To push Presentation Preview over to the Presentation display 

 

Notes:  
• The Presentation Preview screen replaces the entire Presentation display when you click 

Present Preview. (For example, if an exhibit is open in zone 2 in Presentation mode, and you 
load a different exhibit in zone 1 in Presentation Preview, when you push it over the exhibit in 
zone 2 will close.) 

• Native file documents, such as Microsoft Word or PowerPoint, will open to page 1 when 
transferred to the active Presentation display. If a specific page is desired, be prepared to 
move to that page. This limitation does not apply to PDF files. 

1. Ensure the secondary display is enabled in Windows. (See Windows Start > Help and Support for more 
information.) 

2. Ensure Presentation Preferences > Stage > General > Display is set to Secondary Monitor. 

3. Drag the item from Case Explorer or Document Manager to the Presentation Preview tab and prepare it as needed 
using any of the presentation tools. 

4. If needed, move the item to the appropriate zone. 

5. Click  
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To clear Presentation Preview (discarding any annotations) 

Click  

 

Tips:  
• If Mirror Mode is enabled, clicking Clear Presentation clears both the Presentation Preview 

tab and the actual Presentation. 

• Consider using the Save Stages feature to preserve the display before you click Clear 
Presentation. 
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Using Mirror Mode to Control Your 
Presentation Behind the Scenes 
When you enable Mirror Mode on the Presentation Preview tab, you take control of the active presentation from behind the 
scenes. Mirror Mode is designed for situations when you have dual displays connected to your computer (for example, your 
laptop with TrialDirector running as the primary display, and a courtroom projector showing Presentation mode as the 
secondary display). As you drag items on to the Presentation Preview tab and use the Presentation Toolbar to add 
annotations, the same changes appear simultaneously on the Presentation display without toolbars or controls to distract the 
jury. 

Before Enabling Mirror Mode 

• Ensure the secondary display is enabled in Windows. (See Windows Start > Help and Support for more 
information.) 

• Ensure the Presentation Preferences > Stage > General > Display is set to Secondary Monitor. (Mirror Mode will 
work if both the main program and Presentation mode are using the same display, but for practical purposes 
Presentation mode should be configured to open on a secondary display.) 

• Practice your presentation. Remember that when Mirror Mode is enabled, everything you do is live. 

To Activate Mirror Mode 

Click  

When Mirror Mode is enabled, the button looks like this:  

As soon as Mirror Mode is enabled, the Presentation Toolbar and all controls are hidden in Presentation mode. Click the 
button again at any time to turn Mirror Mode off. You can then work on the Presentation Preview tab independently from the 
live Presentation and push the changes over when you are ready. 
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Using Annotations in Presentation 
TrialDirector gives you the flexibility to pre-treat items in Case Explorer or Document Manager, or to make annotations on-the-
fly while you present your case. Use any of the tools on the Presentation Toolbar to apply annotations, regardless of whether 
you're working in Presentation Preview or in Presentation mode. 

Most tools feature a color palette that appears when you right-click on the tool. 

 

Tips:  
• If you've used prior versions of TrialDirector, refer to the Presentation Tool Changes tables 

while you make the transition to the new interface. 

• Hold your mouse over any tool to view a tooltip. Then, spend some time practicing using each 
tool. 

• To quickly undo an annotation while drawing, press ALT.  

• Drag the tools you use most often to the Quick Access Toolbar. 

• Use the Save Stage tool to preserve your on-the-fly annotations. When you load the saved 
stage, you can resume working with the annotations right where you left off. 
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Using Callouts and Annotations in  
Transcripts and Video 
Just as you can use callouts and annotations to emphasize text in documents, you can use them to emphasize graphic 
images, moving video, and moving transcript text. 

Simply select a tool on the Presentation Toolbar, then click-and-drag over the area you want to emphasize. Several examples 
are shown below. 

 

Tip: To quickly change the area that is projected, hold down the right mouse button and select a 
different part of the text, image, or video. 

 Video Transcript Emphasized with Projection Zoom  

and Tear Out Projection  
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Transcript Emphasized with Ellipse  
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Surveillance Video Emphasized with Projection Zoom  
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Presentation Preferences 
Presentation Preferences enable you to customize the look and feel of your presentations, toolbar visibility, exhibit behavior, 
hotkeys, and much more.  

To open Presentation Preferences, do one of the following: 

• From Presentation mode, click the Presentation menu button (far left), and then click Preferences. 

 

• From the main TrialDirector window, open the View menu and click Presentation Preferences. 

Spend some time viewing the available options before you plan your next presentation. As you do this, click to expand or 
collapse groups of options as needed, and expand the Information text to learn more about specific options. 
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The following table lists some of the commonly used settings and where to locate them in Presentation Preferences. 

To do this... Set this option... 

Look & Feel 

Change the background color (theme) Stage > Appearances > Select a Theme 

Change the type of information that 
appears at the top left corner of exhibits 
(or hide it completely) 

Stage > Zones > Caption Boxes 

Make Presentation Mode open on your 
secondary monitor or projector 

Stage > General > Secondary Monitor 

Change the font of transcript text and 
closed captions 

Exhibits > Digital Video Transcripts > Fonts 
and 
Exhibits > Transcripts > Fonts 

Line thickness of all annotations (arrows, 
ellipses, etc.) 

Tools > Annotations 

Stop the lines from appearing when you 
use Projection Zoom 

Tools > Projections > Show Projection Lines (disable) 

Action 

Make videos start playing immediately 
after they're loaded 

Exhibits > Multimedia > Startup Behavior 
and 
Exhibits > Digital Video Transcripts > DVT Play Options 
> Startup Behavior 

Make videos close automatically after 
they finish playing 

Exhibits > Multimedia > Shutdown Behavior 
and 
Exhibits > Digital Video Transcripts > DVT Play Options 
> Shutdown Behavior 

Make exhibits open in a certain zone 
even if you don't select it first 

Stage > Zones > Default Zone Placement 

Make all linked exhibits open in a certain 
zone when DVTs are playing 

Exhibits > Digital Video Transcripts > Linked Exhibits 

Set up custom keystrokes to control 
your presentation 

Hotkeys 
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Saving and Loading Stages 
As you work in Presentation mode loading exhibits into zones and using tools as needed, your work area serves as a stage 
that shows jurors everything you do. Setting up this stage and saving it prior to your courtroom presentation can prevent 
mistakes and save time. Unlike screen snapshots, this feature saves the layout of the actual exhibits. Simply load a saved 
stage and begin playing video, page through a transcript, or do anything else you would normally do in your presentation. 

You can save as many stages as needed and load the stage you need at the right time from a list in Presentation mode. This 
feature also comes in handy when your presentation is interrupted. For example, if court breaks for lunch, use Save Stage so 
that you can quickly return to where you left off when court resumes. 

 

Tips:  
• Because a saved stage retains the history of actions that you did prior to saving it, you can 

use the Undo and Redo buttons to step backward and forward in the presentation. 

• Consider setting the folder prefix (in Presentation Preferences > Tools) to the current date at 
the beginning of each trial day. This will enable you to locate the stages saved for each day of 
the trial more easily. 

 To save a stage 

1. Load, position, and annotate your exhibits and/or other items in Presentation mode. 

2. From the Application Tools, click the Save Stage button. 

 
The stage is automatically saved to a SaveStage folder in the location where the case is saved. (You can find this 
path in Case Properties.) Each saved stage is assigned a name with a prefix and the next number in sequence (i.e. 
SaveStage-000001, SaveStage-000002, etc.) You can set the prefix in Presentation Preferences > Tools and you 
can rename the folder in Windows Explorer if needed. 

To load a saved stage 

1. Use the Navigation Tools to select the SaveStage folder. 

2. Select the stage you want to load, and then click the green button. 

 

Note: If you load a saved stage and display it on a screen with a different display aspect ratio (such as 
a projector in the courtroom), you may notice some visual differences. Although this has been 
minimized, inData recommends you view it on the alternate display prior to a live presentation. 
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Using Screen Snapshot and  
Grab Screen Commands 
Use the Screen Snapshot tool or the Grab Screen (-GS) command to capture a static image of the entire Presentation 
display. The new image is automatically associated with the item that is active at the time of capture. It appears under the 
original item in Case Explorer/Document Manager with -GS and a incremental number appended to the name, as well as in a 
Shapshots workbook. 

This feature is helpful when you need to save an exhibit marked up during trial by a witness as a new exhibit, or if you want to 
use it as part of another presentation or PowerPoint project. However, if you want to save the dynamic layout of your 
presentation (and walk back through the annotations using the Undo and Redo tools), use the Save Stage feature instead. 

 

Note: You can specify the location where Screen Snapshots are stored in Presentation Preferences > 
Tools > Snapshots/Save Stage > Screen Snapshots. 

  

To capture the Presentation display 

1. On the Presentation toolbar, open the Application Tools  

2. Click the Screen Snapshot tool  

-or- 

1. Type -GS 
2. Press ENTER 

 

Tip: To specify your own name for a screen snapshot, type it immediately after the -GS 
command. For example, to name it EX003, type: 
 -GSEX003 
As an alternative, you can rename any item you capture with the Screen Snapshot tool or the 
command after the fact in Case Explorer/Document Manager. 
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